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Dasar-Dasar VB6 
 
 
 
 
 
Visual Basic adalah bahasa pemrograman paling populer. Dan 
versi yang masih cukup populer sekarang adalah VB6. Walaupun 
sudah ada VB.Net, tapi VB6 tetap masih memiliki basis pengguna 
yang banyak. Ini tidak lain disebabkan sifatnya yang sangat ringan 
dan mudah dipakai, serta bahasa pemrogramannya pun berbasis 
basic, yang sangat simpel dan mudah dipelajari. 

1.1 Mengenal VB6 

Microsoft Visual Basic (sering disingkat sebagai VB saja) meru-
pakan sebuah bahasa pemrograman yang menawarkan Integrated 
Development Environment (IDE) visual untuk membuat program 
perangkat lunak berbasis sistem operasi Microsoft Windows 
menggunakan model pemrograman (COM). 

Visual Basic merupakan turunan bahasa pemrograman BASIC dan 
menawarkan pengembangan perangkat lunak komputer berbasis 
grafik dengan cepat. 

Beberapa bahasa skrip seperti Visual Basic for Applications (VBA) 
dan Visual Basic Scripting Edition (VBScript), mirip seperti halnya 
Visual Basic, tetapi cara kerjanya yang berbeda. Jadi, kalau Anda 
belajar Visual Basic, Anda bisa juga memprogram yang lain, 
seperti VBA di Excel, Word, dan PowerPoint. 

Para programmer dapat membangun aplikasi menggunakan 
komponen-komponen yang disediakan oleh Microsoft Visual 
Basic. Program-program yang ditulis dengan Visual Basic juga 
dapat menggunakan Windows API, tapi membutuhkan deklarasi 
fungsi luar tambahan. 
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Dalam pemrograman untuk bisnis, Visual Basic memiliki pangsa 
pasar yang sangat luas. Sebuah survey yang dilakukan pada tahun 
2005 menunjukkan bahwa 62% pengembang perangkat lunak 
dilaporkan menggunakan berbagai bentuk Visual Basic, yang 
diikuti oleh C++, JavaScript, C#, dan Java. 

Oleh karena itu, dengan mempelajari Visual Basic, Anda akan 
memperoleh banyak manfaat. Dari mulai manfaat untuk sekolah 
ataupun untuk pekerjaan Anda. 

1.1.1 Sejarah 

Bill Gates, pendiri Microsoft, memulai bisnis perangkat lunak 
dengan mengembangkan interpreter bahasa Basic untuk Altair 
8800, untuk kemudian ia ubah agar dapat berjalan di atas IBM PC 
dengan sistem operasi DOS. Perkembangan berikutnya ialah 
diluncurkannya BASICA (basic-advanced) untuk DOS. Setelah 
BASICA, Microsoft meluncurkan Microsoft QuickBasic dan 
Microsoft Basic (dikenal juga sebagai Basic Compiler). 

Visual Basic adalah pengembangan dari bahasa komputer BASIC 
(Beginner’s All-purpose Symbolic Instruction Code). Bahasa 
BASIC diciptakan oleh Professor John Kemeny dan Thomas 
Eugene Kurtz dari Perguruan Tinggi Dartmouth pada pertengahan 
tahun 1960-an.  

 

Gambar 1.1 Bill Gates, pendiri Microsoft  
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Bahasa program tersebut tersusun mirip dengan bahasa Inggris 
yang biasa digunakan oleh para programmer untuk menulis 
program-program komputer sederhana yang berfungsi sebagai 
pembelajaran bagi konsep dasar pemrograman komputer. 

 

Gambar 1.2 Logo Microsoft terbaru  

Sejak saat itu, banyak versi BASIC yang dikembangkan untuk 
digunakan pada berbagai platform komputer, seperti Microsoft 
QBASIC, QUICKBASIC, GWBASIC, IBM BASICA, Apple BASIC, 
dan lain-lain. 

 

Gambar 1.3 Contoh bahasa BASIC  

Apple BASIC dikembangkan oleh Steve Wozniak, mantan karya-
wan Hewlett Packard dan teman dekat Steve Jobs (pendiri Apple 
Inc.). Steve Jobs pernah bekerja dengan Wozniak sebelumnya 
(mereka membuat game arcade “Breakout” untuk Atari).  

Mereka mengumpulkan uang dan bersama-sama merakit PC, dan 
pada tanggal 1 April 1976 mereka secara resmi mendirikan 
perusahaan komputer Apple. Popularitas dan pemakaian BASIC 
yang luas dengan berbagai jenis komputer turut berperan dalam 
mengembangkan dan memperbaiki bahasa itu sendiri. 
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Hingga akhirnya Microsoft membidani lahirnya Visual Basic yang 
berbasis GUI (Graphic User Interface) bersamaan dengan Microsoft 
Windows. Pemrograman Visual Basic begitu mudah bagi pemula 
dan programmer pemula karena ia menghemat waktu pemrog-
raman dengan tersedianya komponen-komponen siap pakai. 

Visual Basic pun terus populer hingga akhirnya Visual Basic 
berkembang menjadi beberapa versi, sampai yang terbaru, yaitu 
Visual Basic 2012. Namun, Visual Basic 6.0 tetap menjadi versi 
yang cukup populer karena mudah dalam membuat programnya 
dan ia tidak menghabiskan banyak memori sehingga sangat 
ringan digunakan. 

BASIC di tangan Microsoft, dikembangkan sebagai bahasa yang 
diinterpretasi (BASICA) dan juga bahasa yang dikompilasi 
(BASCOM) di mana Visual Basic adalah implementasi sebagai 
gabungan keduanya. 

Programmer yang menggunakan Visual Basic akan mengompilasi 
kode bahasa pemrograman menjadi bahasa mesin. Sayangnya, 
meskipun sudah terkompilasi jadi bahasa mesin, DLL bernama 
MSVBVMxx.DLL tetap dibutuhkan kalau mau menjalankan 
program hasil VB6. Namun, karekteristik bahasa terkompilasi 
tetap muncul (yaitu lebih cepat dari kalau kita pakai mode 
terinterpretasi). 

1.1.2 Versi-Versi Visual Basic  

Visual Basic pertama adalah VB 1.0. Software ini diperkenalkan 
pada tahun 1991. Membawakan konsep pemrograman dengan 
metode drag-and-drop untuk membuat tampilan aplikasi, Visual 
Basic 1.0 ini diadaptasi dari prototype generator form yang 
dikembangkan oleh Alan Cooper dan perusahaannya, bernama 
Tripod.  

Microsoft kemudian mengontrak Cooper dan perusahaannya untuk 
mengembangkan Tripod menjadi sistem form yang dapat di-
program untuk Windows 3.0, di bawah kode nama Ruby. 

Tripod tidak memiliki bahasa pemrograman sama sekali. Ini 
menyebabkan Microsoft memutuskan untuk mengombinasikan 
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Ruby dengan bahasa pemrograman Basic dalam membuat Visual 
Basic. 

Berikut ini beberapa tahapan dari pengembangan Visual Basic 
hingga menjadi versi 6.0: 

1. Proyek Thunder dimulai. 

2. Visual Basic 1.0 dirilis untuk Windows pada Comdex/ 
Windows Trade Show di Atlanta, Georgia pada Mei 1991. 

3. Visual Basic 1.0 untuk DOS dirilis September 1992. Ba-
hasa pemrogramannya sendiri tidak terlalu kompatibel 
dengan Visual Basic untuk Windows, karena sesungguhnya 
itu adalah versi selanjutnya dari kompiler BASIC berbasis 
DOS yang dikembangkan oleh Microsoft sendiri, yaitu 
QuickBASIC. Antarmuka program ini sendiri mengguna-
kan antarmuka teks, dan memanfaatkan kode-kode ASCII 
tambahan untuk menyimulasikan tampilan GUI. 

4. Visual Basic 2.0 dirilis pada November 1992. Lingkungan 
pemrogramannya lebih mudah untuk digunakan, dan 
kecepatannya lebih ditingkatkan. 

5. Visual Basic 3.0 dirilis pada musim semi 1993 dan hadir 
dalam dua versi: Standar dan Professional. VB3 juga 
menyertakan versi 1.1 dari Microsoft Jet Database Engine 
yang dapat membaca dan menulis database Jet/Access 
1.x. 

6. Visual Basic 4.0 (Agustus 1995) adalah versi pertama 
yang dapat membuat program 32-bit seperti program          
16-bit. VB4 juga memperkenalkan kemampuannya dalam 
membuat aplikasi non-GUI. Jika versi sebelumnya meng-
gunakan kontrol VBX, sejak VB4 dirilis Visual Basic meng-
gunakan kontrol OLE (dengan ekstensi file *.OCX), yang 
lebih dikenal kemudian dengan kontrol ActiveX. 
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Gambar 1.4 Contoh screen shot Visual Basic 4 

7. Dengan versi 5.0 (Februari 1997), Microsoft merilis Visual 
Basic eksklusif untuk versi 32-bit dari Windows. Para 
programmer yang lebih memilih membuat kode 16-bit 
dapat mengimpor program yang ditulis dengan VB4 ke 
versi VB5, dan program-program VB5 dapat dikonversi 
dengan mudah ke dalam format VB4. 

8. Visual Basic 6.0 (pertengahan 1998) telah diimprovisasi di 
beberapa bagian, termasuk kemampuan barunya, yaitu 
membuat aplikasi web. Meskipun kini VB6 sudah tidak 
didukung lagi, tetapi file runtime-nya masih didukung 
hingga Windows 7. 

 

Gambar 1.5 Logo Visual Basic 6.0 
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Visual Basic menjadi populer karena kemudahan desain form 
secara visual dan adanya kemampuan untuk menggunakan 
komponen-komponen ActiveX yang dibuat oleh pihak lain.  

Namun, komponen ActiveX memiliki masalahnya tersendiri yang 
dikenal sebagai DLL hell. Pada Visual Basic .NET, Microsoft 
mencoba mengatasi masalah DLL hell dengan mengubah cara 
penggunaan komponen (menjadi independen terhadap registry). 

1.2 Instalasi VB6 

Instalasi VB6 dapat dilakukan dengan langsung menginstal pada 
file installer yang ada. Caranya seperti berikut ini: 

1. Klik dua kali pada installer VB6. 

2. Klik pada I accept the agreement. Kemudian klik Next. 

 

Gambar 1.6 Klik I accept the agreement di EULA dari Installation 
Wizard VB6 

3. Di Product Number and User ID, isikan pada serial number 
program, kemudian isikan nama, dan klik Next. 
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Gambar 1.7 Pengisian Product number dan User ID 

4. Pilih versi instalasi Custom dan klik Next. 

 

Gambar 1.8 Versi instalasi custom  

5. Pilih folder instalasi untuk common file, lalu klik Next. 



9 

 

Gambar 1.9 Pengisian folder instalasi untuk Common File 

6. Muncul prompt, klik Continue untuk melanjutkan proses 
instalasi. 

 

Gambar 1.10 Klik Continue di prompt yang muncul 

7. Muncul jendela yang menampilkan product ID, klik OK. 
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Gambar 1.11 Jendela yang menampilkan Product ID 

8. Pilih komponen-komponen yang akan diinstal dengan 
memberi tanda cek. Klik Continue kemudian. 

 

Gambar 1.12 Pemilihan komponen yang akan diinstal  

9. Tunggu hingga file-file disalin. 

 

Gambar 1.13 Proses penyalinan file berlangsung  



11 

10. Restart komputer. 

11. Berikutnya di instalasi MSDN, hilangkan cek kalau tidak 
mau menginstal MSDN. Klik Next. 

 

Gambar 1.14 Instalasi MSDN  

12. Di Other client tools, langsung saja klik Next. 

 

Gambar 1.15 Jendela Other Client Tools  
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13. Di Server Setups, klik juga Next. 

 

Gambar 1.16 Jendela Server setups  

14. Di Register over the web, hilangkan cek agar tidak perlu 
registrasi via web. Klik Finish. 

 

Gambar 1.17 Jendela Register over the web  
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15. Kalau pakai Windows 7, sebelum bisa menjalankan, klik 
kanan dan pilih menu Properties. 

 

Gambar 1.18 Klik kanan dan pilih menu Properties  

16. Kemudian klik tab Compatibility, dan cek Run this 
program in compatibility mode for Windows XP. Dan 
Disable efek-efek visual. 

 

Gambar 1.19 Pengaturan compatibility  

17. Untuk menjalankan program yang sudah terinstal, klik 
pada Start > All Programs > Visual Studio > MS Visual 
Basic 6.0. 
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Gambar 1.20 Menu untuk menjalankan program di Visual Studio 6 

18. Kalau masih tampilan kosong, seperti berikut ini: 

 

Gambar 1.21 Tampilan kosong IDE (integrated development 
environment) VB6 

19. Kalau ingin membuat proyek baru, klik File > New Project. 
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Gambar 1.22 Membuat proyek baru  

20. Pilih Standard EXE dan klik OK. 

 

Gambar 1.23 Memilih standard exe  

21. Muncul form seperti berikut. 

 

Gambar 1.24 Form IDE dari Visual Basic 6 
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1.2.1 Mengenal Lingkungan Kerja IDE VB6 

Tampilan IDE dari VB6 ini perlu Anda pahami agar bisa efektif 
bekerja dengan VB6. Berikut ini contoh lingkungan kerja IDE VB6. 

 

Gambar 1.25 Lingkungan kerja VB6 

Bagian pertama toolbar. Bentuk toolbar seperti berikut ini. 

 

Gambar 1.26 Tampilan toolbar 

Beberapa komponen di toolbar ini seperti berikut: 

•  Membuat proyek baru. 

•  Membuat item baru. 

•  Membuka file atau proyek baru. 

•  Menyimpan file atau proyek. 

•  Untuk mengedit kode-kode program. 
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•  Untuk menjalankan program, pause, dan 
menghentikan. 

•  Menampilkan Project Explorer. 

•  Menampilkan jendela Properties.  

1.2.2 Component  

Bilah berikutnya adalah component, di mana Anda bisa mema-
sukkan komponen-komponen ke dalam form yang ada di tengah. 
Beberapa komponen yang penting akan dijelaskan di bawah ini. 

 

Gambar 1.27 Bilah Components 

Berikut ini beberapa tombol di bilah Components yang penting: 

•  Untuk mengembalikan pilihan ke normal/pointer 
mouse. 
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•  Komponen untuk menampilkan picturebox. 

•  Komponen untuk memasukkan label. 

•  Komponen untuk memasukkan textbox. 

•  Komponen untuk memasukkan group box. 

•  Komponen untuk memasukkan button. 

•   Komponen untuk memasukkan checkbox. 

•  Komponen untuk memasukkan radio button. 

•  Komponen untuk memasukkan combobox. 

•  Komponen untuk memasukkan listbox. 

•  Komponen untuk memasukkan slider horizontal. 

•  Komponen untuk memasukkan slider vertikal. 

•  Komponen untuk memasukkan timer. 

•  Komponen untuk memasukkan DriveListBox. 

•  Komponen untuk memasukkan DirListBox. 

•  Komponen untuk memasukkan FileListBox. 

•  Komponen untuk memasukkan shape. 

•  Komponen untuk memasukkan line. 

•  Komponen untuk memasukkan image. 
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•  Komponen untuk memasukkan data. 

•  Komponen untuk memasukkan OLE (Object Linked 
and Embedded). 

Untuk melihat lebih jelas bagaimana aliran pembuatan program di 
VB6, ikuti contohnya di langkah pembuatan program pertama 
“Halo Dunia”. 

1.3 Membuat Program Halo Dunia  

Untuk membuat program pertama halo dunia, ikuti langkah-
langkah berikut ini: 

1. Buat proyek baru dengan klik pada File > New Project. 

 

Gambar 1.28 File > New Project untuk membuat proyek baru  

2. Pilih jenis proyek Standard EXE. 

 

Gambar 1.29 Pemilihan jenis proyek Standard EXE  
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3. Muncul form masih kosong. 

 

Gambar 1.30 Proyek baru masih kosong  

 

Gambar 1.31 Form masih kosong  

4. Klik pada form, kemudian set properti Caption menjadi 
“Program pertama”. 
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Gambar 1.32 Set Caption menjadi “Program pertama” 

5. Maka nilai Caption (kalau di vbnet istilahnya text), berganti 
menjadi “Program pertama”. 

 

Gambar 1.33 Caption berubah menjadi Program Pertama  

6. Sekarang masukkan button dengan klik pada komponen 
CommandButton di bilah Components. 
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Gambar 1.34 Klik pada bilah CommandButton di commands  

7. Maka form akan berisi command seperti berikut ini. 

 

Gambar 1.35 Button sudah dimasukkan ke form  

8. Klik pada button, kemudian ganti properti Caption, dengan 
teks “Klik Aku”. 

 

Gambar 1.36 Mengganti properti caption dari button  
dengan “Klik Aku” 
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9. Maka caption dari button akan berubah. 

 

Gambar 1.37 Caption dari button berubah  

10. Klik dua kali pada button kalau mau mengisikan kode 
untuk button tersebut. Kemudian coba isikan kode berikut: 

Dim teks As String 
teks = "Halo Dunia, Selamat Datang ke Pemrograman VB 6" 
MsgBox teks, vbInformation, "Selamat Datang" 
 

 

Gambar 1.38 Kode yang dimasukkan  

11. Klik tombol Run seperti berikut, atau tekan F5 juga bisa. 
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Gambar 1.39 Klik tombol Run  

12. Muncul form seperti berikut, klik tombol Klik Aku. 

 

Gambar 1.40 Klik pada tombol Klik Aku  

13. Maka terlihat messagebox yang muncul karena perintah 
MsgBox seperti berikut. 

 

Gambar 1.41 MsgBox muncul karena perintah MsgBox  
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14. Untuk menyimpan hasil pembuatan proyek atau form, klik 
File > Save Project. 

 

Gambar 1.42 Penyimpanan save project  

15. Tentukan lokasi penyimpanan dan klik tombol Save. 

 

Gambar 1.43 Menentukan lokasi penyimpanan dan klik Save  

1.4 Mengenal Objek Komponen-Komponen  

Di bagian ini kita akan membahas tentang objek komponen-
komponen. Untuk mempermudah pelajaran, tiap komponen akan 
diletakkan dalam satu form. Untuk itu berikut cara membuat form 
baru. 
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Cara menambahkan form dan mengeset agar startup form menjadi 
form tertentu, seperti berikut ini: 

1. Klik tombol Add Form untuk menambahkan form. 

 

Gambar 1.44 Klik tombol Add Form untuk menambahkan form  

2. Muncul jendela Add Form, klik Form biasa untuk dibuka. 

 

Gambar 1.45 Klik pada jendela Add Form  

3. Maka muncul form baru yang masih kosong. Ini siap untuk 
dibuat menampung objek komponen-komponen baru. 
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Gambar 1.46 Menampung objek komponen-komponen baru  

4. Untuk mengganti agar form tertentu yang aktif jika diklik 
tombol Run, maka klik menu Project > Project Properties. 

 

Gambar 1.47 Project Properties  

5. Pilih objek form tertentu yang akan dijalankan sebagai 
startup pada combobox Startup Object. 
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Gambar 1.48 Penentuan Startup Object 

6. Alhasil, jika dijalankan, terlihat form yang terpilih akan 
dibuka.  

 

Gambar 1.49 Form yang dipilih sudah terbuka  

1.4.1 PictureBox  

Pertama kita akan memasukkan objek PictureBox. Ini adalah objek 
untuk menampilkan gambar tertentu. Berikut ini demo contoh 
menggunakan objek PictureBox pada Visual Basic 6.0: 
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1. Buat form baru. 

2. Klik tombol PictureBox pada bilah Components. 

 

Gambar 1.50 Klik pada tombol PictureBox  

3. Letakkan pictureBox tersebut pada form sehingga terlihat 
seperti berikut ini. 

 

Gambar 1.51 PictureBox terlihat di form  

4. Set AutoSize ke True di kotak Properties. 
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Gambar 1.52 Set AutoSize ke True di kotak Properties  

5. Desain awalnya belum ada picture di situ. Untuk membuat 
picture, cek pada tombol panah di properties Picture. 

 

Gambar 1.53 Menentukan properti Picture 

6. Muncul jendela Load Picture, kemudian pilih picture yang 
ingin ditampilkan. 
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Gambar 1.54 Pemilihan picture yang ingin ditampilkan  

7. Tampilan PictureBox akan berubah setelah ada picture di 
situ. 

 

Gambar 1.55 Picture ada setelah diubah properti Picture-nya 

8. Ganti caption pada form dengan “Pengenalan Picture”. 
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Gambar 1.56 Penggantian caption dari form  

9. Maka form dan picture akan terlihat seperti berikut. 

 

Gambar 1.57 Form dan picture berganti  

10. Jalankan program, maka terlihat gambar terlihat karena 
adanya picture. 
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Gambar 1.58 Program terlihat karena adanya picture  

11. Sekarang kita ingin menambahkan button, masukkan ke 
bawah PictureBox. 

 

Gambar 1.59 Menambahkan button ke bawah PictureBox 

12. Klik pada button, kemudian set caption-nya dengan 
“Sembunyikan gambar”. 
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Gambar 1.60 Setting caption dengan ”Sembunyikan gambar” 

13. Maka caption jadi “Sembunyikan Gambar”. 

 

Gambar 1.61 Ganti caption ke Sembunyikan gambar 

14. Klik dua kali pada button tersebut lalu isikan kode berikut:  
Private Sub Command1_Click() 
Me.Picture1.Picture = Nothing 
End Sub 
 

15. Jalankan program, terlihat tampilan picture seperti berikut. 
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Gambar 1.62 Klik button di tampilan picture  

16. Klik pada button, maka picture akan terlihat kosong 
karena Picture sudah diset ke Nothing. 

 

Gambar 1.63 Klik pada Sembunyikan Gambar 

1.4.2 Label dan TextBox  

Objek berikutnya adalah label dan textbox. Label digunakan untuk 
menampilkan teks, sementara textbox digunakan untuk menam-
pung teks masukan dari pengguna program. 
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Berikut ini contoh penggunaan label dan textbox: 

1. Masukkan form baru. 

2. Set caption ke “Demo Label dan TextBox”. 

 

Gambar 1.64 Set caption ke “Demo Label dan TextBox” 

3. Form terlihat berubah karena caption-nya menjadi seperti 
yang sudah diisikan. 

 

Gambar 1.65 Caption sudah berubah  

4. Kemudian klik Label seperti berikut, di mana tombol di 
samping kanan Label adalah Textbox. 



37 

 

Gambar 1.66 Klik pada Label  

5. Masukkan label ke form. 

 

Gambar 1.67 Memasukkan label ke form  

6. Ganti caption dengan teks “Nama:”. 
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Gambar 1.68 Penggantian caption dengan teks “Nama:” 

7. Masukkan lagi label kedua, isi caption dengan teks 
“Alamat:”. 

 

Gambar 1.69 Pengisian caption dengan nama “Alamat:” 
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8. Tampilan form setelah diganti teks di labelnya menjadi 
seperti berikut ini. 

 

Gambar 1.70 Tampilan form setelah diganti teks di labelnya  

9. Kemudian masukkan textbox sebanyak dua buah. 

 

Gambar 1.71 Memasukkan textbox sebanyak dua buah 

10. Untuk Text1, kosongkan dulu text-nya. 
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Gambar 1.72 Mengosongkan properti text dari objek komponen Text1 

11. Kemudian masih di Text1, scroll ke atas dan ganti 
namanya menjadi txtNama. Penggantian name ini memu-
dahkan Anda membaca kode yang dibuat nantinya. 

 

Gambar 1.73 Penggantian name dari Text1 menjadi txtNama 
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12. Klik textbox kedua, dan ganti name menjadi txtAlamat. 

 

Gambar 1.74 Penggantian name dari Text2 

13. Untuk txtAlamat ini, kosongkan teks-nya dengan mengo-
songkan properti Text. 

 

Gambar 1.75 Pengisian properti Text 
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14. Hasilnya, di form terlihat dua buah label dan dua buah 
textbox. 

 

Gambar 1.76 Dua buah label dan dua buah textbox ada di form  

15. Masukkan button ke dalam form. 

 

Gambar 1.77 Memasukkan button ke dalam form  

16. Ganti caption dari button ke “Proses”. 
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Gambar 1.78 Mengganti caption dari button  

17. Maka tampilan button di form menjadi seperti berikut ini. 

 

Gambar 1.79 Tampilan button di form setelah diganti caption-nya  

18. Klik dua kali pada button tersebut, lalu isikan kode berikut: 
Private Sub Command1_Click() 
MsgBox "Nama Anda adalah " + Me.txtNama.Text + _ 
" Sementara Alamat Anda ada di " + Me.txtAlamat.Text 
End Sub 
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19. Penjelasan dari kode di atas adalah akan ditampilkan 
messagebox yang berisi teks, di mana teks disusun 
menggunakan teks yang diisikan di txtNama dan 
txtAlamat. 

 

Gambar 1.80 Pengisian teks di button  

20. Jalankan program, lalu isikan nama dan alamat Anda. Klik 
button Proses. 

 

Gambar 1.81 Klik pada button Proses  

21. Maka muncul messagebox seperti berikut, terlihat teks 
masukan/input dari user akan terlihat di messagebox yang 
muncul. 
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Gambar 1.82 Messagebox yang muncul berisi teks dari txtNama  
dan txtAlamat  

1.4.3 Button 

Button sudah dipakai di beberapa contoh proyek pengenalan 
program sebelumnya. Tapi kali ini kita akan mencoba mengenal 
button lebih detail. Berikut ini langkah-langkah tutorial pengenalan 
button. 

1. Buat form baru, ganti caption-nya menjadi “Mengenal 
button”. 

 

Gambar 1.83 Memasukkan form baru dengan caption  
“Mengenal Button” 



46 

2. Maka terlihat form menjadi seperti berikut. 

 

Gambar 1.84 Form setelah caption diganti  

3. Masukkan dua buah button. 

 

Gambar 1.85 Memasukkan dua buah button command1  
dan command2  

4. Untuk Command1, ganti Name menjadi btnPertama. 
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Gambar 1.86 Penggantian name dari command1 menjadi btnPertama 

5. Kosongkan caption dari btnPertama. 

 

Gambar 1.87 Pengosongan caption dari btnPertama 

6. Untuk command2, ganti saja Caption-nya menjadi 
”Proses”. 
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Gambar 1.88 Penggantian caption menjadi Proses 

7. Klik dua kali pada Command2 dan isikan kode berikut: 
Private Sub Command2_Click() 
Me.btnPertama.Caption = "&Klik Aku" 
End Sub 
 

8. Klik dua kali pada btnPertama dan isikan kode berikut ini: 
Private Sub btnPertama_Click() 
MsgBox "Ini teks dimunculkan karena tombol ALT + K ditekan" 
End Sub 
 

9. Jalankan program, klik pada tombol Proses. 

 

Gambar 1.89 Menjalankan program  
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10. Setelah tombol proses diklik, maka caption dari button 
menjadi “&Klik Aku”. Tanda & menunjukkan shortcut. 
Jadi, nantinya huruf K akan menjadi shortcut untuk 
tombol. Anda juga bisa menekan tombol keyboard ALT+K 
kalau mau mengklik tombol tersebut. 

 

Gambar 1.90 Tombol btnPertama memiliki caption  
dengan shortcut ALT+K  

11. Anda bisa mencoba menekan tombol ALT+K untuk meng-
akses button ini. 

 

Gambar 1.91 Tekan ALT+K untuk mengakses button  
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1.4.4 Mengenal Checkbox 

Checkbox adalah pilihan dengan opsi yang bisa dipilih lebih dari 
satu secara bersamaan. Ini berlawanan dengan radio button/option 
button yang hanya bisa mengakomodasi satu pada saat yang 
bersamaan.  

Ikuti tahap latihan berikut untuk mengenal checkbox: 

1. Masukkan form baru. 

2. Set Caption dari form menjadi “Pengenalan checkbox”. 

 

Gambar 1.92 Pengesetan caption dari form menjadi  
“Pengenalan checkbox” 

3. Form menjadi berubah caption-nya, seperti terlihat di 
gambar berikut ini. 

 

Gambar 1.93 Form berubah caption-nya  
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4. Klik pada checkbox di General. 

 

Gambar 1.94 Klik pada checkbox di General  

5. Masukkan 3 buah checkbox. 

 

Gambar 1.95 Memasukkan 3 checkbox  

6. Masukkan satu buah command. 
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Gambar 1.96 Memasukkan satu command di bawah checkbox  

7. Ganti caption dari button menjadi “Makanan Favorit”. 

 

Gambar 1.97 Penggantian caption dari button  

8. Maka button akan berubah teks. 
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Gambar 1.98 Button berubah teks  

9. Untuk checkbox1, ganti name menjadi chkAyam dan set 
caption dengan “Ayam Goreng”. 

 

Gambar 1.99 Penggantian name dan caption dari checkbox  

10. Maka di form terlihat perbedaannya, klik pada checkbox2. 



54 

 

Gambar 1.100 Checkbox1 sudah diubah caption dan klik  
pada checkbox2 

11. Ganti Name dari checkbox2 dengan chkBakso, dan 
Caption-nya dengan “Bakso”. 

 

Gambar 1.101 Checkbox Bakso  

12. Maka di form akan berubah. 
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Gambar 1.102 Form akan berubah  

13. Untuk checkbox3, ganti Name menjadi chkRendang dan 
Caption menjadi “Rendang”. 

 

Gambar 1.103 Mengganti name dan caption dari checkbox3 

14. Maka semua checkbox akan berubah, klik dua kali pada 
tombol yang ada untuk mengisikan kode. 
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Gambar 1.104 Klik pada tombol yang ada  

15. Maka isikan kode berikut ini: 
Private Sub Command1_Click() 
 Dim makanan As String 
 If Me.chkAyam.Value = 1 Then 
 makanan = makanan + Me.chkAyam.Caption + ", " 
 End If 
  
 If Me.chkBakso.Value = 1 Then 
 makanan = makanan + Me.chkBakso.Caption + ", " 
 End If 
  
 If Me.chkRendang.Value = 1 Then 
 makanan = makanan + Me.chkRendang.Caption + ". " 
 End If 
  
MsgBox " Favorit anda adalah " + makanan  
  
End Sub 
 

16. Checkbox ini bisa memilih lebih dari satu opsi. 

 

Gambar 1.105 Cek pada checkbox Ayam Goreng dan Bakso,  
pemilihan lebih dari satu  
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17. Sekarang coba cek pada Ayam Goreng, dan klik tombol, 
maka muncul messagebox bahwa favorit Anda adalah 
Ayam Goreng. 

 

Gambar 1.106 Checkbox sudah terlihat 

18. Pilih dua checkbox, maka kalau diklik tombol, akan 
muncul dua makanan favorit. 

 

Gambar 1.107 Checkbox berisi dua makanan favorit  

19. Coba cek semuanya dan klik button, maka terlihat semua 
akan terlihat. 
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Gambar 1.108 Messagebox berisi semua makanan yang ada 

1.4.5 Mengenal Frame/GroupBox  

Komponen Frame atau groupbox gunanya untuk mengelompok-
kan objek-objek tertentu menjadi satu-kesatuan. Anda bisa me-
ngeset tampilan dan lain sebagainya dari frame ini nantinya. 

Berikut ini contoh langkah-langkah bagaimana mengenal frame/ 
groupbox di VB6: 

1. Masukkan form baru. 

2. Ganti caption dari form ini dengan “Mengenal Groupbox”. 

 

Gambar 1.109 Mengenal caption dari form  
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3. Masukkan dua buah frame, Frame1 dan Frame2. 

 

Gambar 1.110 Memasukkan dua buah frame  

4. Masukkan objek-objek di frame tersebut. Anda bebas 
memasukkan objek apa pun, atau bisa melihat seperti 
contoh berikut. 

 

Gambar 1.111 Memasukkan objek-objek ke dalam frame  
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5. Untuk frame pertama, isikan dengan caption “Frame 
pertama”. 

 

Gambar 1.112 Frame pertama  

6. Ganti caption dari frame kedua dengan pengesetan di 
Caption. 

 

Gambar 1.113 Pengaturan caption dari frame kedua  
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7. Hasilnya menjadi seperti berikut. 

 

Gambar 1.114 Penggantian caption dari frame  

8. Masukkan command dan ganti properti caption menjadi 
“Proses”. 

 

Gambar 1.115 Mengganti caption dari command  
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9. Klik dua kali pada button tersebut untuk mengisikan kode. 

 

Gambar 1.116 Klik pada button  

10. Isikan kode berikut: 
Private Sub Command2_Click() 
Me.Frame1.BackColor = vbBlack 
Me.Frame2.Visible = False 
 
End Sub 
 

11. Kode di atas akan membuat back color dari frame 1 
menjadi hitam, dan frame 2 akan disembunyikan. 

12. Jalankan program, dan klik tombol Proses. 

 

Gambar 1.117 Klik pada Proses  
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13. Maka kalau sudah diklik, frame akan berubah sesuai 
dengan kode yang dibuat. 

 

Gambar 1.118 Contoh hasil penanganan frame dengan kode  

1.4.6 Mengenal Option Button  

Option button digunakan untuk menawarkan pilihan ke user, di 
mana hanya ada satu pilihan yang bisa diakomodasi. Berikut ini 
contoh langkah-langkah penggunaan option button dan kode 
untuk menanganinya: 

1. Masukkan form baru, dan ganti caption dengan “Mengenal 
Option button”. 

 

Gambar 1.119 Mengenal Option button  
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2. Tampilan program menjadi seperti berikut. 

 

Gambar 1.120 Tampilan program terlihat  

3. Masukkan option button dengan klik pada tombol Option 
button di bilah Components. 

 

Gambar 1.121 Pengisian option button  

4. Masukkan dua option button, dan satu command. 
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Gambar 1.122 Memasukkan dua option button dan satu command  

5. Kemudian klik pada Option1 dan set caption menjadi Laki. 

 

Gambar 1.123 Penggantian caption dari option1 

6. Klik Option2, dan set caption-nya ke Perempuan. 
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Gambar 1.124 Set Caption ke Perempuan  

7. Kemudian ganti caption dari button ke “Proses”. 

 

Gambar 1.125 Ganti caption ke Proses  

8. Tampilan form tampak seperti berikut ini. Klik tombol 
Proses, lalu klik dua kali untuk memasukkan kode ke 
dalamnya. 
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Gambar 1.126 Form setelah option dan command button  
diganti caption-nya  

9. Isikan kode berikut: 
Private Sub Command1_Click() 
Dim jenis_kelamin As String 
 
 If Me.Option1 = True Then 
 jenis_kelamin = "Laki-Laki" 
 Else 
 If Me.Option2 = True Then 
jenis_kelamin = "Perempuan" 
 End If 
  
 End If 
MsgBox "Jenis kelamin Anda adalah " + jenis_kelamin 
End Sub 
 

10. Kode di atas menampilkan messagebox yang menjelaskan 
jenis kelamin yang dipilih.  

11. Pilih sebuah option, misalnya Laki. 
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Gambar 1.127 Klik pada salah satu option 

12. Pilih pada opsi satunya. Lihat apa yang terjadi, ternyata 
opsi satunya akan hilang. Ini menunjukkan sifat option 
button yang hanya mengakomodasi satu pilihan saja. 

 

Gambar 1.128 Kalau satunya dipilih,  
yang satunya tidak akan bisa terpilih  

13. Klik Laki, lalu klik Proses. Muncul messagebox di situ. 



69 

\ 

Gambar 1.129 Klik pada Proses, maka messagebox akan terlihat 
menampilkan jenis pilihan  

14. Klik Perempuan, kemudian klik Proses, maka messagebox 
akan menampilkan data Perempuan. 

 

Gambar 1.130 Klik pada option button Perempuan  
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1.4.7 Mengenal ComboBox dan ListBox 

Combobox merupakan sebuah kotak berisi teks, di mana Anda 
bisa mengisikan list/daftar di dalamnya. Ikuti latihan berikut untuk 
mengetahui tentang comboBox: 

1. Masukkan form baru, kemudian ganti caption-nya dengan 
“Mengenal ComboBox”. 

 

Gambar 1.131 Mengganti caption dari form  
dengan string “Mengenal ComboBox” 

2. Klik ikon ComboBox di bilah Components. 

 

Gambar 1.132 Klik pada ikon ComboBox  
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3. Isikan combobox dan command button. 

 

Gambar 1.133 Mengisikan combobox dan Commandbutton 

4. Ganti caption dari command dengan “Proses”. 

 

Gambar 1.134 Mengganti caption dari command  
dengan string “Proses” 

5. Untuk combobox, isikan text dengan “Silakan Pilih”. 
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Gambar 1.135 Pengisian teks dengan Silakan Pilih  

6. Maka tampilan form setelah caption dan text dimasukkan 
seperti berikut. 

 

Gambar 1.136 Tampilan form setelah penggantian caption dan text 

7. Tambahkan list di combobox dengan klik pada List, 
kemudian isikan list sesuai keinginan Anda. 
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Gambar 1.137 Pengisian list di combobox  

8. Anda bisa mengisikan indeks di ItemData. 

 

Gambar 1.138 Pengisian indeks di ItemData 

9. Kembali ke form, klik dua kali pada button. 
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Gambar 1.139 Form sebelum dijalankan  

10. Isikan kode berikut ini: 
Private Sub Command1_Click() 
MsgBox "Pilihan Anda adalah " + Me.Combo1.Text 
End Sub 
 

11. Jalankan program, tampilan awal program seperti berikut.: 

 

Gambar 1.140 Tampilan awal program  

12. Pilih item dari list di combobox. 
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Gambar 1.141 Pemilihan item di combobox  

13. Maka muncul messagebox yang berisi item teks dari 
combobox yang dipilih. 

 

Gambar 1.142 Messagebox berisi item dari combobox yang dipilih  

14. Kemudian tambahkan ListBox ke bawahnya. 
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Gambar 1.143 Menambahkan ListBox ke bawahnya 

15. Masukkan daftar untuk listbox di List. 

 

Gambar 1.144 Memasukkan daftar untuk ListBox  

16. Maka terlihat isi dari listbox akan berubah. 



77 

 

Gambar 1.145 Isi dari Listbox sudah ada 

17. Kemudian update kode untuk tombol Proses dengan kode 
seperti berikut ini: 

Private Sub List1_Click() 
Me.Caption = Me.List1.Text 
End Sub 
 

18. Jalankan program.  

 

Gambar 1.146 Menjalankan program  

19. Pilih pada item yang ingin dipilih, baik di combobox atau 
listbox, kemudian klik Proses. 
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Gambar 1.147 Caption dari form berubah  

20. Maka muncul caption dari form akan berubah sesuai 
dengan text dari Listbox. 

1.4.8 ScrollBar  

Scrollbar digunakan untuk menggeser bilah, di mana kalau digeser 
nilainya akan berubah. Anda bisa menentukan nilai min dan max 
dari scrollbar. Baik scrollbar vertikal atau horizontal prinsipnya 
sama. 

Berikut ini contoh pembuatan program dengan scrollbar: 

1. Masukkan form baru. 

2. Ganti caption dengan “Mengenal Scrollbar”. 

 

Gambar 1.148 Mengganti caption dengan “Mengenal scrollbar” 
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3. Masukkan scrollbar. 

 

Gambar 1.149 Memasukkan scrollbar jenis vertikal  

4. Tentukan nilai min dari scrollbar menjadi nol, sementara 
nilai max menjadi 100. 

 

Gambar 1.150 Penentuan nilai min dan max dari scrollbar  

5. Masukkan label. 
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Gambar 1.151 Memasukkan label untuk menampilkan nilai pilihan 

6. Kosongkan properti caption dari label. 

 

Gambar 1.152 Pengosongan properti caption dari label  

7. Klik dua kali pada scrollbar kemudian isikan kode berikut: 
Private Sub VScroll1_Change() 
Me.Label1.Caption = Me.VScroll1.Value 
End Sub 
 

8. Jalankan program. 
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Gambar 1.153 Menjalankan program pertama kali  

9. Geser scrollbar, maka akan berubah nilai di label. 

 

Gambar 1.154 Kondisi label akan berubah  

10. Kalau scrollbar digeser lagi, terlihat tampilan nilai akan 
berubah. 

 

Gambar 1.155 Tampilan nilai berubah ketika scrollbar digeser 
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1.4.9 Timer  

Timer adalah objek yang setiap beberapa waktu akan meng-
eksekusi kode. Jarak waktu ini dinamakan interval. Berikut ini 
contoh bagaimana memanfaatkan timer di program: 

1. Masukkan form. 

2. Ganti caption dari form dengan “Mengenal Timer”. 

 

Gambar 1.156 Mengenal caption dari form dengan “Mengenal Timer” 

3. Kemudian masukkan label dan kosongkan caption-nya. 

 

Gambar 1.157 Memasukkan label dan mengosongkan caption-nya 

4. Kemudian masukkan timer ke form. 
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Gambar 1.158 Memasukkan timer ke form  

5. Set interval 100 milidetik. 

 

Gambar 1.159 Pengesetan interval dari timer  

6. Ketikkan kode berikut di klik dua kali timer: 
Private Sub Timer1_Timer() 
Me.Label1.Caption = Now 
End Sub 
 

7. Maka jam akan terlihat. 
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Gambar 1.160 Jam akan terlihat selalu ter-update  
karena adanya timer 

1.4.10 File Explorer  

Adanya file dan directory explorer memudahkan Anda mengambil 
path dari file tertentu. Berikut ini contoh penggunaannya: 

1. Masukkan form baru. Ganti caption-nya dengan “Mengenal 
Drive, Folder dan File”. 

 

Gambar 1.161 Mengganti caption  

2. Masukkan driveListBox. 
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Gambar 1.162 Klik pada DriveListBox  

3. Kemudian masukkan untuk Directory dan juga FileListbox 
sehingga terlihat tampilan seperti berikut di form. 

 

Gambar 1.163 Memasukkan direktori dan file  

4. Masukkan kode-kode untuk directory_change, 
drive_change, dan File_click. 
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Private Sub Dir1_Change() 
Me.File1.Path = Me.Dir1.Path 
 
End Sub 
 
Private Sub Drive1_Change() 
Me.Dir1.Path = Me.Drive1.Drive 
 
End Sub 
 
Private Sub File1_Click() 
Me.Caption = Me.File1.Path + "\" + Me.File1.FileName 
End Sub 
 

5. Jalankan program.  

 

Gambar 1.164 Program dijalankan  

6. Buka drive D, kemudian klik pada folder tertentu. 

 

Gambar 1.165 Buka drive D  



87 

7. Klik salah satu file, maka di caption dari program akan 
terlihat path dari file yang dipilih. 

 

Gambar 1.166 Path dari file yang dipilih akan terbuka  

8. Kalau mau menambahkan komponen lain yang belum ada 
di bilah Components, Anda bisa klik kanan dan memilih 
menu Components. 

 

Gambar 1.167 Klik kanan dan memilih menu Components  

9. Ccek pada nama komponen tersebut, dan klik OK. 
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Gambar 1.168 Cek pada komponen yang akan ditambahkan  

1.4.11 Menu  

Sebuah form bisa memiliki menu utama. Untuk menambahkan 
menu utama, caranya seperti berikut: 

1. Buka form yang akan diberi menu utama. 

2. Klik menu Tools > Menu Editor. 

 

Gambar 1.169 Menu Tools > Menu Editor untuk menambahkan  
menu buat form  
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3. Isikan caption, nama, dan klik Next. 

 

Gambar 1.170 Mengisi caption dan nama menu  

4. Anda bisa menambahkan lainnya dengan mengisi seperti 
sebelumnya. 

 

Gambar 1.171 Menambahkan menu baru  
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5. Menu bisa diatur pangkatnya menggunakan tombol panah 
kanan untuk menurunkan pangkat. 

 

Gambar 1.172 Sebelum menu diturunkan pangkatnya  

6. Setelah diturunkan, terlihat ada garis putus-putus di situ. 

 

Gambar 1.173 Menu setelah diturunkan pangkatnya  
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7. Anda bisa menambahkan lagi, menu juga bisa diberi 
shortcut dengan menyelanya dengan karakter &. 

 

Gambar 1.174 Menambahkan menu ketiga 

8. Untuk pemberian nama, usahakan yang mudah dibaca 
sehingga kodenya nanti mudah dimengerti. 

 

Gambar 1.175 Pemberian nama di kotak teks Name 
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9. Di form, terlihat tampilan akan seperti ini.  

 

Gambar 1.176 Tampilan di form akan terlihat adanya menu 

10. Jika diklik, menu memperlihatkan submenu yang ada. 

 

Gambar 1.177 Menu memperlihatkan submenu yang ada 

11. Anda bisa menambahkan menu sebanyak yang Anda 
inginkan. 
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Gambar 1.178 Menambahkan menu-menu baru 

12. Maka menu akan terlihat lebih banyak di form. 

 

Gambar 1.179 Menu bertambah di form  
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